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Custom Reporting 
Overview
The Custom Reporting allows Enterprise client users to create, save, and share 
ad-hoc reports using Euna Grants's data mart. Advanced client users will have 
custom reports configured for them by our Customer Success team. Custom 
reports are only available with the Custom Reporting advanced segment. 

Although creating custom reports does not require coding knowledge, it does 
require a technical understanding of data tables and joins, as well as access to 
Euna Grants's data dictionary and data mart. Contact your Customer Success 
team contact or create a support ticket for access. We also recommend that 
users have their reporting requirements defined before attempting to create a 
custom report. 
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Custom Report Basics
This section details the basics of custom reporting, such as creating, viewing, 
and editing a custom report. 
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Custom Reports 
For clients with Custom Reporting

Custom reports allows Organizational Admin, Department Admin, and Fund 
Admin to create ad-hoc reports using Euna Grants's data mart, including 
applicant data. Custom reports are available for Grantor, Grantee, and Lifecycle 
clients. These reports can be accessed by Organizational Admin, Department 
Admin and Users, Project Admin and Users, Fund Admin and Users, Grant 
Managers, Opportunity Managers, and Additional Staff. 

Although creating custom reports does not require coding knowledge, it does 
require a technical understanding of data tables and joins, as well as access to 
Euna Grants's data dictionary and data mart. We also recommend that users 
have their reporting requirements defined before attempting to create a custom 
report. 

How To View a Custom Report 
1.	 Open Reports>Custom Reports. 

2.	 Click a report name. 

How To Create a Custom Report
Prerequisite: Must be Organizational Admin, Department Admin, or Fund Admin

1.	 Open Reports>Custom Reports. 

2.	 Click the  (Add) icon in the Icon Bar. 

3.	 Add a report name. 

4.	 Select the Custom Reports folder for a public report (will be visible to 
others in your organization) or the Custom Reports>Private folder for a 
private report (only visible to you). 

5.	 Add a report description (optional). This description will appear on 
Reports>Custom Reports. 

Categories
6.	 Open the Categories tab. 

7.	 Select a data category to add to your report. This category corresponds to 
a data table in the data mart. 

8.	 Click the arrow button to add the category. Additional related categories 
can be added to a report. 

 Note
Once the first category has 

been added, only categories 
that are related by joins can be 

subsequently added.

Icons
INFO Help

Home Make 
Homepage

 Print

 Help

 Create

 Edit

trash-alt Delete

save Save

shield-alt Make Private

users Make Public
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Sorts
9.	 Open the Sorts tab. 

10.	 Select a data category to sort. Data table columns for that category will be 
shown. Data columns correspond to Euna Grants fields. 

11.	 Select a column name to sort data. Click the arrow button to add 
column. 

12.	 Select sort order. 

Filters
13.	 Open the Filters tab. 

14.	 Select a data field to filter by. This will affect which data is shown in the 
report by default.  

15.	 Click the arrow button to add field. 

16.	 Add a data condition. This is the criteria that must be met for data to show 
on the report. 

17.	 Check the Prompt For Value checkbox to prompt the user for a filter 
value before report is run. 

Layout
18.	 Open the Layout tab.

19.	 Select a field to show on the report. The field name will appear as a column, 
with each row being a corresponding entry. 

20.	 Click the arrow button to add field. 

21.	 To display a formula/calculation instead of field data, click the fx (Formula 
icon) (optional). 

a.	 In the pop-up window, select a function type and click +Add, or edit 

 Note
Sorts are hierarchical, with the 

topmost sort applied first. 
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the formula directly in the formula text field. 

b.	 Click Okay. 

22.	 Select a summary function (optional). This indicates how the total for the 
column is calculated, such as a sum or count. 

23.	 In the Summarize By field, select categories to group by (optional). Click 
the category name for additional formatting options. 

a.	 Check the Add space before each unique item checkbox to add a 
blank row before each group.

b.	 Check the Include Header at the beginning checkbox to put a field 
value above each group. Choose which field to use, or click the formula 
icon to create a formula for the text.

c.	 Check the Include Total at the end checkbox to include the 
summary values at the end of every group.

24.	 To add a header at the top of each page, check the Page Header 
checkbox. This is selected by default. 
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25.	 Click Page Header for additional formatting options.  

a.	 To add report titles, check the Include title at the top of every page 
checkbox. This is selected by default.

b.	 To add images, check the Include image at the top of every 
page checkbox and click Change Image to select a file from your 
computer.

c.	 If both images and titles are shown, select the position and number of 
columns to span for each. 

26.	 To add a footer at the bottom of each page, check the Page Footer 
checkbox. 

27.	 Click Page Footer for additional formatting options.  

a.	 To add a page numbers, check the Include page number at the 
bottom of every page checkbox. 

b.	 To add images, check the Include image at the bottom of every 
page checkbox and click Change Image to select a file from your 
computer. 

c.	 If both images and page numbers are shown, select the position and 
number of columns to span for each. 

28.	 Check the Grant Total checkbox to summarize all data fields at the end of 
the report. 
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29.	 In the preview pane, click a sample cell and adjust formatting with the 
format toolbar as needed. 

30.	 Click the Save (Save icon). 

How To Edit a Custom Report
1.	 Open Reports>Custom Reports>report name.

2.	 Click the pencil-alt (Edit icon) in the Icon Bar. 

3.	 Update information as necessary. 

4.	 Click the save (Save icon).

How To Delete a Custom Report
1.	 Open Reports>Custom Reports>report name.

2.	 Click the trash-alt (Delete icon) in the Icon Bar. 

3.	 In the confirmation pop-up window, click Delete.

How To Make a Public Custom Report 
Private
By making the custom report private, other users will no longer be able to view 
or run the report. 

1.	 Open Reports>Custom Reports>report name.

2.	 Click the shield-alt (Make Private icon) in the Icon Bar. 

3.	 In the confirmation pop-up window, click Make Private. 

How To Make a Private Custom Report 
Public
By making the custom report public, other users in your organization will be 
able to view and run the report. 
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1.	 Open Reports>Custom Reports>report name.

2.	 Click the users (Make Public icon) in the Icon Bar. 

3.	 In the confirmation pop-up window, click Make Public.

How To Make a Report Your Homepage
The  (Make Homepage icon) is available on all reports in the Icon Bar. 

1.	 Navigate to the desired report under Reports in the left-hand Navigation 
menu.

2.	 Select the  (Make Homepage icon) in the upper right hand corner in the 
Icon Bar.
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Custom Report Features
This section details each section and feature within the Euna Grants reporting 
engine. 
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Name
The Name section allows users to specify the report name, save location, and 
create a report description. From this section, users can save the report as 
public (visible to your organization) or private. 

Report Name
Report names cannot contain slashes (/), backslashes (\), colons (:), asterisks 
(*), question marks (?), quotation marks ("), less than symbols (<), greater than 
symbols (>), or vertical bars (|).  

Public Reports 
Public reports are available to all Organizational Admin, Department Admin 
and Users, Grant Managers, Opportunity Managers, and Additional Staff in 
your organization. Public reports are saved in the Custom Reports folder. On 
the Custom Reports list, public reports are indicated by a No in the Is Private 
column.

Private Reports
Private reports are only available to the user who created them. Private reports 
are saved in the Custom Reports>Private folder. On the Custom Reports list, 
private reports are indicated by a Yes in the Is Private column. 

Report Description
Report descriptions are optional, but encouraged. Report descriptions are 
visible on Reports>Custom Reports. 

Filter Description
Filter descriptions are visible if the user is prompted to select a value before 
running the report. This filter is available by checking the Prompt For Value 
checkbox on the Filter tab. 

Icons
 Print

 Help

 Create

 Edit

save Save
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Categories
The Categories section allows users to select what data will appear on the 
report. Data categories correspond to Euna Grants data tables, which are 
organized by rows and columns. Columns correspond to Euna Grants data 
fields; rows correspond to data entries. 

For example, the data table of Grant Additional Staff would have columns of 
Grant ID, Individual ID, and Individual. You can view Euna Grants data table 
names and columns in the Euna Grants Data Dictionary or Data Mart Schema 
documents. 

Grant Additional Staff
Grant ID Individual ID Individual

101 1888 Raymond Chandler

101 1894 Dashiell Hammett

101 1892 James M. Cain

Adding Categories
Entire categories (data tables) are added to report at a time. From there, you 
can filter which columns (fields) are visible on the report. Categories can be 
added by clicking the category name and arrow button. Once the first category 
is added, only related categories can be added. As more categories are added, 
more related categories may become available. 

Categories are related by joins. You can view table joins in the Euna Grants Data 
Mart Schema document. 

Suppress Duplicates
Because of the relationship between categories, duplicate values may appear 
when you run your report. For example, on a report of Additional Staff and 
Grant, the same staff members may be attached to multiple grants. This could 
result in duplicate staff members appearing when your run your report. By 
checking the Suppress Duplicates checkbox next to a category, only the first 
instance of a staff name will appear, and the following rows will appear blank. 

Icons
 Print

 Help

 Create

 Edit

save Save
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Sorts
The Sorts section allows users to determine the default order for the entry 
data. You can select which columns (fields) will be used to sort the rows for 
each category (data table). The type of data will determine how the data can be 
sorted. 

Selecting Columns
Users can select columns from each data table by clicking the column name and 
arrow button. The column name will then appear in the Sort By section. 

Sort Order
Once columns have been added, users can select how the data will be ordered. 
Sorts are hierarchical with the topmost sort applied first. Options will vary based 
on data type. 

Ascending (lowest number on top) or descending (highest number on top) order

Ascending (oldest date on top) or descending (newest date on top)

Ascending (A on top) or descending (Z on top)

Icons
 Print

 Help

 Create

 Edit

save Save

Numeric 

Date

Text
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Filters
The Filters section allows users to determine which rows (data entries) from a 
category (data table) are displayed. 

Adding Fields
Users can select categories from the dropdown, and then select fields (columns) 
to filter by. Fields can be selected by clicking the column name and arrow 
button. The column name will then appear in the Filter By section. 

Filter Conditions
Users can select a filter condition for each field. Only rows that meet the 
condition will appear on the report. To create a condition, click the field name in 
the Filter By section, and then select a condition and parameters.

Condition Data Type Example Filter Example Results

Equal To Any 08/08/2019 08/08/2019 
08/08/2019 12:00 AM

Not included: 
08/08 
08/08/2019 2:00 PM

Not Equal To Any 08/08/2019 08/08 
08/08/2019 2:00 PM

Less Than Numeric, 
Date

08/08/2019 08/07/2019

Less Than Or 
Equal To

Numeric, 
Date

08/08/2019 08/07/2019 
08/08/2019

Greater Than Numeric, 
Date

08/08/2019 08/08/2019 5:00 PM 
08/09/2019

Greater Than 
Or Equal To

Numeric, 
Date

08/08/2019 08/08/2019 
08/09/2019

Starts With Text, Numeric 101 10112345

Not Starts 
With

Text, Numeric 101 55512345

Ends With Text, Numeric 101 12345101

Does Not End 
With

Text, Numeric 101 12345555

Contains Text, Number 101 555101555

Icons
 Print

 Help

 Create

 Edit

save Save
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Condition Data Type Example Filter Example Results

Does Not 
Contain

Text, Number 101 55555555

Is Between Numeric, 
Date

1, 3 1 
1.5 
2 
3

Is Not 
Between

Numeric, 
Date

1, 3 0.999 
4

Is One Of Any 1, 3 1 
3

Is Not One Of Any 1, 3 5

Grouping Filters
If you have multiple filters, you can choose how they should be grouped. Check 
the Group With Next Filter checkbox to group the current filter with the 
next filter in the list. 

You can reorder filters with the  up and  down arrows in the Filter By section. 

Filters that are grouped together will appear in parentheses in the Summary 
field. 

Filters that are grouped together can have an And or Or relationship. An And 
relationship means that both filter conditions must be met for data to display. 
An Or relationship means that data will display if either condition is met. 

Prompt For Value
If you want the report to request a filter value when the report is run, select the 
Prompt For Value checkbox. If you added a filter description on the Name 
tab, it will appear in the pop-up prompt when the report is run. 
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Layout
The Layout section allows users to determine the data visible and look of the 
report. For each data field added, the report will create a column header. 
Additionally, subtotals, grand totals, and page headers and footers can be 
added.

Adding Fields
Users can select categories from the dropdown, and then select fields (columns) 
to add to the report. Fields can be selected by clicking the column name and 
arrow button. The column name will then appear in the Data Field section. 
Once added, the field will appear in the Preview section with a header and 
placeholder values. 

Formulas
If desired, you can add a formula instead of data from a field by clicking the fx 
(Formula icon). You can then select and add a function type from a preexisting 
list, or edit the formula directly in the formula text field. See Formula Types for 
more information. 

Summary Functions and Summarize 
By
The Summary Function column is used to make subtotals and grand totals.

 

Totals the all of the data in the data field.

Returns the number of rows in the data field.

Takes the mean of the data in the data field.

Displays the lowest value in the data field.

Displays the highest value in the data field.

To display summary, check the data field name checkbox in the Summarize 

Icons
 Print

 Help

 Create

 Edit

save Save

Sum

Count

Average

Minimum

Maximum
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By area. 

In the Summarize By area, click the data field name to configure summary 
options, such as summary field type, spacing, header, and footer for each 
category. 

Page Header
Page headers will display information at the top of every page of the report. 

To display header, check the Page Header checkbox below the Summarize 
By area. 

Click Page Header to configure header options, such as report title and image 
position and column span. 

Page Footer
Page footers will display information at the bottom of every page of the report. 

To display footer, check the Page Footer checkbox below the Summarize By 

 Note
Position and column span can 

only be configured if both title and 
image are selected. 
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area. 

Click Page Footer to configure footer options, such as report title and image 
position and column span. 

Grand Total
Grand totals display the total summary for a data field, based on the summary 
function selected. To display grand totals for the report, check the Grand Total 
checkbox. This will display totals for each data field selected in the Summarize 
By area. 

Preview and Formatting
At the bottom of the Layout tab, a preview will display how the report will 
appear based on the fields that have been added. To change the text in a 
header or footer, double-click the cell and edit the text. To resize columns, drag 
the left or right border of the column. To insert a blank column between two 
data fields, click between to columns then click plus Add Blank. 

To style a cell, click the cell use the format bar to style.

Undo and Redo

The undo and redo buttons allow users to undo and redo styling as needed.

 Note
Position and column span can 

only be configured if both title and 
image are selected. 
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Layout Options

The Layout Options menu allows users to hide rows and add background colors 
to rows. To hide the data rows for the selected field, check the Suppress Detail 
Rows checkbox. 

To add row background colors, click plus New. 

To change the color, click the color shade (white by default). In the menu, 
select a color. Add additional colors for alternating rows. 

Font 

Users can select a font, size, and styling for the cell text.

Color

Users can select a color for the text and for the background of the cell.
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Format Cells

Users can configure cell content format.

Values can have any format. 

Specify number of decimal places, commas, symbols, and negative value 
formatting for number values.  

Specify date value format.

Values must be text format.

The Border tab allows users to format the borders around cells. 

General

Number 

Date 

Text

Border
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Alignment

Users can select how cell contents should align to the cell vertically (top, middle, 
bottom) and paragraph alignment (left, center, right, full-justified).
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Options
The Options section allows users to determine report information and output, 
filter prompts, export options, and report type.

General Options
Include Set Up
On the General tab, users can choose to display the selected data categories, 
sorts and filters for the report. If displayed, the report set up information can be 
appear as the first or last page of the report.

Filter Execution Window
The filter execution window determines the type of filter menu displays for 
reports which have a prompt for filter values before running. If the Always Show 
Filters in Report Viewer is checked, the filter will be shown each time the report 
is run.  

Displays a standard filter menu where the filter, conditions, and values can be 
changed. Filters can also be grouped. For Euna Grants, the default and standard 
filters are the same.

Icons
 Print

 Help

 Create

 Edit

save Save

Default and Standard
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Displays a simplified filter menu where only the condition and value can be 
changed.

Displays a simplified filter menu where only the filter value can be changed.

No Data Qualify Display Mode
If there is no qualifying data for the report, an error message or an empty report 
can be displayed. 

Export Options
Allow Execution in Viewer
The export options dropdown can be shown (True) or hidden (False) for the 
custom report. 

Allowed Export Types
Users can select which export options are available in the export dropdown.

Default Export Type
Users can select the default export type shown in the export options dropdown 
menu. In Euna Grants, PDF is the default. 

Report Tree Shortcut
Users can select if the report runs or exports by default from the Custom 
Reports page. 

Show Grid

Simple with Operator

 

Simple without 
Operator
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Users can select if the report will show grid lines by checking the Show Grid 
checkbox. 

Simulate PDF
Users can select if the report will appear as if on a PDF page. 

Excel Options
By checking the Suppress Formatting checkbox, the report will export report 
data only to Excel, without any formatting. 

Page Options
Users can configure page size, orientation, and content fit. 

Advanced Options
Convert Express Report to an Advanced Report
Custom reports can be converted to Advance Custom Reports. This feature set 
requires additional training. To proceed, contact your Account Management 
Representative before converting your report. 

Exclamation-triangle Warning
This action cannot be undone. 
Do not proceed until you have 

received Advanced Report 
Development training.
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Formula Types
Arithmetic and Geometric
Basic mathematical functions, as well as number field manipulation like truncation and rounding.

Function Type Description Example Formula Example 
Return

Abs Returns the absolute value of 
a number.

Abs(-23.1) 23.1

Acos Returns the arccosine, or 
inverse cosine, of a number. 
Input must be from -1 to 1.

Acos(-.231) 1.8039016825 
5052

Acosh Returns the inverse hyperbolic 
cosine of the given number. 
Input must be a real number 
greater than or equal to 1.

Acosh(10) 2.993223

Asin Returns the arcsine of the 
given number in radians, in 
the range -Pi/2 to Pi/2. Input is 
the sine of the angle you want 
and must be in the range from 
-1 to 1.

Asin(-0.5) 0.5236

Asinh Returns the inverse hyperbolic 
sine of a number.

Asinh(-2.5) -1.64723

Atan Returns the arctangent, or 
inverse tangent, of a number. 
Atan returns an angle given in 
radians in the range -Pi/2 to 
Pi/2.

Atan(1) 0.785398 (pi/4)

Atan2 Returns the angle from the 
x-axis to a line containing 
the origin (0, 0) and a point 
with coordinates (x,y). Input 
requires two values, the x and 
y coordinates.

Atan2(1, 1) 0.785398 (pi/4)

Atanh Returns the inverse hyperbolic 
tangent of a number. The 
input must be from -1 to 1.

Atanh(.76159416) 1 
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Function Type Description Example Formula Example 
Return

Ceiling Returns the number rounded 
up to the nearest multiple of 
significance. Input requires 
two values, the number to be 
rounded and the multiple of 
significance.

Ceiling(4.42,.05) 4.45

Cos Returns the cosine, of an angle 
in radians

Cos(1.047) 0.500171

Cosh Returns the hyperbolic cosine 
of a number.

Cos(4) 27.30823

Even Returns a number rounded up 
to the nearest even integer.

Even(1.5) 2

Exp Returns e raised to the power 
of the input.

Exp(1) 2.718282

Fixed Returns the first argument 
rounded to the number of 
decimal places specified in 
the second argument. Can 
optionally add TRUE/FALSE to 
omit commas. Default is FALSE 
(to include commas).

Fixed(1234.5678, 2) 1,234.56

Floor Rounds the number down 
to the nearest multiple of 
significance. Input requires 
two values, the number to be 
rounded, and the multiple of 
significance.

Floor(2.6, .5) 2.5

Global 
Numeric 
Format

Returns a numeric string value 
whose format is based on the 
session format.

GlobalNumericFormat 
({Region.Population})

5,000  
(population)

Int Rounds a number down to the 
nearest integer.

Int(2.6) 2`

Ln Returns the natural logarithm 
of a number.

Ln(86) 4.454347

Log10 Returns the base 10 logarithm 
of a number.

Log10(86) 1.934498451

Mod Returns the remainder after 
first argument is divided by 
the second argument.

Mod(27,5) 2
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Function Type Description Example Formula Example 
Return

Odd Returns a number rounded up 
to the nearest odd integer.

Mod(1.5) 3

Pi Returns pi accurate to 15 
digits.

Pi() 3.14159265358 
979

Power Returns the result of the first 
argument raised to the second 
argument. Can also use ^ 
symbol.

Power(5,2)

--OR--

5^2

25

Product Returns the product of the 
arguments. Can also use * 
symbol.

Product(5,2)

--OR--

5*2

10

Quotient Returns the integer of a 
division, does not include 
remainder. Can also use / 
symbol.

Quotient(5,2)

--OR--

5/2

2

Rand Returns an evenly distributed 
random number between 0 
and 1 (inclusive).

Rand() 0

Round Returns a rounded number. 
The first argument is the 
number to round. The second 
argument is the number of 
decimal places. 

Round(5.236, 2) 5.24

Sin Returns the sine of a number. Sin(1.047) 0.08659266112 
87823

Sinh Returns the hyperbolic sine of 
a number.

Sinh(4) 27.18991719712 
78

Sqrt Returns the positive square 
root of a number.

Sqrt(25) 5

Tan Returns the tangent of a 
number.

Tan(.785) 0.99920

Tanh Returns the hyperbolic 
tangent of a number.

Tanh(-2) 0.96403

Truncate Truncates a number to an 
integer.

Truncate(9.9) 9
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Database and Data Type
Database and data type functions are used for determining the type of information contained in a 
cell. This can be helpful for error and validation checks.

Function Type Description Example Formula Example 
Return

DataRowCount Returns the number of rows 
retrieved from the data 
source.

DataRowCount() 10 (number of 
rows/entries)

IsEven Checks if a value is an even 
number.

IsEven([A1]) TRUE if even 
number, FALSE 
if odd number

IsLogical Checks if a value is TRUE or 
FALSE.

IsLogical([A1]) TRUE (if cell 
[A1] is "TRUE/
FALSE")

IsNoData 
Qualified

Returns TRUE if no data 
qualified for the report 
execution. Otherwise it 
returns FALSE.

IsNoDataQualified() FALSE (if report 
can be run)

IsNonText Checks if a value is not text, 
such as dates, numbers, 
images, and blank cells.

IsNonText([A1]) FALSE (if cell 
[A1] is "TRUE/
FALSE")

IsNumber Checks if a value is a number. IsNumber([A1]) FALSE (if cell 
[A1] is "TRUE/
FALSE")

IsOdd Checks if a value is an odd 
number. 

IsOdd([A1]) TRUE (if cell 
[A1] is "15")

IsText Checks if a value is text. IsText([A1]) TRUE (if cell 
[A1] is "TRUE/
FALSE")

Null Returns a null value Null

Type Identifies the value type as a 
number (1) or text (2).

Type(“John Smith”) 2

Date
Date functions can be used to do calculations and formatting on Date values.

Function Type Description Example Formula Example 
Return

Date Creates a date value from 
numeric year, month, and day.

Date(2019,7,4) July 4, 2019
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Function Type Description Example Formula Example 
Return

DateAdd Returns the sum of a date and 
a quantity of time with three 
arguments. First argument 
is string of interval to add: 
years (yyyy), quarters (q), 
months (m), weeks (w), weeks 
of year (ww),  days (d), hours 
(h), minutes (m), seconds (s). 
Second argument is number 
of time to add. Third argument 
is date value. 

DateAdd('h',1,Now()) 8/09/2019 (date 
and time 1 hour 
from now)

Date 
Custom 
Format

Modifies date format. Defaults 
to MM/DD/YY. 

DateCustomFormat 
(Date(2018,2,24), "MM-dd-
yy")

02-24-18

DateDiff Returns the amount of time 
between two dates as an 
integer with three arguments. 
First argument is string of 
interval to subtract: years 
(yyyy), quarters (q), months 
(m), weeks (w), weeks of 
year (ww),  days (d), hours 
(h), minutes (m), seconds (s). 
Second argument is a date 
value to be subtracted from 
base value. Third argument is 
base value. 

DateDiff('yyyy', 
Date(1787,9,17), Now())

231 (number 
of years since 
9/17/1787)

DateValue Converts a date in text format 
(e.g. '30-jan-2008') to a date 
value. Time is always ignored. 
Returns represent midnight in 
server's local time. 

DateValue('30-jun- 2011') 6/30/2011

Day Returns the day portion of a 
date as an integer. 

Day({Appointment.Date}) 15 (date of 
appointment)

Day360 Returns the number of days 
between two dates based on a 
360-day year. 

Day360({Appointment.
Date}, Today())

5 (number of 
days between 
today and 
appointment)
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Function Type Description Example Formula Example 
Return

GlobalDate 
Format

Returns a DATE value with 
format based on the session 
format.

GlobalDateFormat 
({Appointment.Date})

July 15th (date 
of appointment 
with session 
format)

GlobalDate 
TimeFormat

Returns a DATETIME value 
with format based on the 
session format.

GlobalDateTime 
Format({Appointment.
Date})

July 15th 2pm 
(date and time 
with session 
format)

Hour Returns the hour of a time 
value ranging from 0 (12:00 
AM) to 23 (11:00 PM).

Hour("2:50:05 PM") 14

Minute Returns the minute of a time 
value ranging from 0 to 59.

Minute("2:50:05 PM") 50

Month Returns the month of a date 
value ranging from 1 (January) 
to 12 (December)

Month({Appointment.
Date})

7 (month of the 
appointment)

MonthName Returns the name of the 
month for a given date.

MonthName(2) 

--OR--

MonthName("02/24/1991")

February

Now Returns today’s date and 
time (in local server time). If 
embedding in other functions 
use Now(‘false’).

Now() 8/08/2019 
2:50:05 PM 
(current date 
and time)

QuarterName Returns the fiscal quarter for 
a given date, as text from Q1 
to Q4.

Quarter("02/24/1991") Q1

Quarter 
Number

Returns the fiscal quarter for a 
given date, as a number from 
1 to 4.

Quarter("02/24/1991") 1

Second Returns the seconds of a time 
value ranging from 0 to 59. If 
no seconds, 0 is assumed.

Second("2:50:05 PM") 5

Time Returns the number of ticks in 
a period of hours, minutes and 
seconds (h,m,s).

Time(14,50,5) 534050000000
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Function Type Description Example Formula Example 
Return

TimeFormat1 Returns the time component 
of a DATETIME input as a time 
object.

Note: Cell must be formatted 
as text. 

TimeFormat1 
({Appointment.Date})

2:50 PM (time 
of appoint-
ment)

TimeValue Converts a time in text 
format (i.e., “02-50-05”) to 
a time value. Must include 
time separator (i.e., 12:00, 
not 1200). AM is assumed by 
default, do not use periods 
(i.e., AM not A.M.). 

Note: Cell must be formatted 
as text. 

TimeValue(Time(14,50,5)) 14:50:05

Today Returns today’s date with no 
time. If embedding in other 
functions use Today(‘false’). 
Use Now function for date 
with time. 

Today() 8/08/2019 
(current date)

Year Returns the year of a date as a 
whole number, ranging from 1 
to 9999.

Year(Today()) 2019 (this year)

Financial
Common methods for monetary calculations such as interest and depreciation.

Function Type Description Example Formula Example 
Return

Db Returns the depreciation 
of an asset using the fixed-
declining balance method. 
First argument is initial 
cost. Second argument is 
salvage value at the end of 
depreciation. Third argument 
is useful life in number of 
years. Fourth argument is 
year to be calculated. Fifth 
argument is number of 
months in the first year. 

Db(1000000,100000,6,1,7)

Db([initial cost], [salvage 
value], [life], [year], 
[number of months in first 
year])

186,083.33 
(Depreciation in 
first year, with 
only 7 months 
calculated)
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Function Type Description Example Formula Example 
Return

Ddb Returns the depreciation of 
an asset using the double-
declining balance method. 
First argument is initial 
cost. Second argument is 
salvage value at the end of 
depreciation. Third argument 
is useful life in number of 
years. Fourth argument is 
year to be calculated. Fifth 
argument is the rate at which 
the balance declines (default 
is 2).

Ddb(2400,300,10,1,2)

Ddb([initial cost], [salvage], 
[life], [period], [rate])

480.00 
(first year's 
depreciation)

Fv Returns the future value 
of an investment based on 
periodic, constant payments 
and a constant interest rate. 
First argument is interest rate. 
Second argument is number 
of payments. Third argument 
is amount per payment. 
Fourth argument is present 
value. Fifth argument is when 
payments are due: beginning 
(1) or end (0) of period.

Fv(.06/12, 10, -200, -500, 1)

Fv([annual interest 
rate]/12, [number of 
payments], [payment 
amount], [present value], 
[when payment is due]) 

2,581.40 
(future value of 
investment)

IntRate Returns the interest rate for 
a fully invested security. First 
argument is settlement date. 
Second argument is maturity 
date. Third argument is 
investment amount. Fourth 
argument is redemption value. 
Fifth argument is actual/360 
basis. 

IntRate (Date(2008,2,15), 
Date(2008,5,15), 1000000, 
1014420,2)

IntRate([settlement date], 
[maturity date],  
[investment], [redemption 
value], [basis])

0.05768 
(discount rate)
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Function Type Description Example Formula Example 
Return

Ipmt Returns the interest payment 
for a given period for an 
investment based on periodic, 
constant payments and a 
constant interest rate. First 
argument is annual interest. 
Second argument is year. 
Third argument is years of 
loan. Fourth argument is 
present value of loan.

Ipmt(.1/12, 1*3, 3, 8000)

Ipmt([interest rate],  
[period], [years of loan], 
[present value])

-22.41 (interest 
due in the first 
month)

Nper Returns the number of 
periods for an investment 
based on periodic, constant 
payments and a constant 
interest rate. First argument 
is annual interest rate. 
Second argument is payment 
per period. Third argument 
is present value. Fourth 
argument is future value. Fifth 
argument is when payments 
are due: beginning (1) or end 
(0) of period.

Nper(.012/12, -100, -1000, 
10000, 1)

Nper([interest rate],  
[payment], [present  
value], [future value], 
[when payments are due])

60 (number of 
periods for the 
investment)

Npv Calculates the net present 
value of an investment by 
using a discount rate and a 
series of future payments 
(negative values) and income 
(positive values). Rate is the 
rate of discount over the 
length of one period. First 
argument is annual discount 
rate. Second argument is 
initial cost of investment. 
Third argument is return from 
first year. Fourth argument is 
return from second year.

Npv(.10, -10000, 3000, 
4200)

Npv([annual discount rate], 
[initial cost of investment], 
[return from first year], 
[return from second year])

1,188.44 (net 
present value of 
the investment)
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Function Type Description Example Formula Example 
Return

Pmt Calculates the payment for 
a loan based on constant 
payments and a constant 
interest rate. First argument is 
annual interest rate. Second 
argument is number of 
months of payments. Third 
argument is loan amount. 

Pmt(.08/12, 10, 10000)

Pmt([annual interest 
rate]/12, [number of 
months of payments], [loan 
amount], 0, 1)

-1,037.03 
(monthly 
payment for 
loan)

Ppmt Returns the payment on the 
principal for an investment 
based on constant payments 
and a constant interest 
rate. First argument is 
annual interest rate. Second 
argument is when payments 
are due: beginning (1) or end 
(0) of period. Third argument 
is number of years. Fourth 
argument is loan amount. 

Ppmt(.10/12, 1, 2*12, 2000)

Ppmt([annual interest 
rate]/12, [when payments 
are due], [number of years 
of loan]*12, [loan amount])

-75.62 (payment 
on principle for 
the first month 
of the loan)

Pv Returns the present value of 
an investment. First argument 
is interest rate. Second 
argument is number of years 
money will be paid out. Third 
argument is amount paid out 
per period. Fourth argument 
is future value. Fifth argument 
is when payments are due: 
beginning (1) or end (0) of 
period.

Pv(.08/12, 12*20, 500, , 0)

Pv([interest rate on money 
paid out]/12, 12*[number 
of years till payout], 
[amount paid], [future 
value], [when payments are 
due])

-59,777.15 
(present value 
of annuity)

Rate Returns the interest rate per 
period of an annuity. First 
argument is years of loan 
(multiplied by 12 for number 
of months). Second argument 
is payment Third argument is 
loan amount. 

Rate(4*12, -200, 8000)

Rate([years of loan]*12, 
[monthly payment], [loan 
amount])

.01 (monthly 
rate of loan)
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Function Type Description Example Formula Example 
Return

Sln Returns the straight-line 
depreciation of an asset for 
one period. First argument is 
initial cost of asset. Second 
argument is salvage value. 
Third argument is useful life of 
asset. 

Sln(30000, 7500, 10)

Sln([initial cost], [salvage], 
[life])

2250 
(depreciation 
allowance for 
each year)

Syd Returns the sum-of-years' 
digits depreciation of an 
asset for a specified period. 
First argument is initial cost 
of asset. Second argument is 
salvage value. Third argument 
is useful life of asset. Fourth 
argument is period and must 
use same unit as life. 

Syd(30000, 7500, 10, 1)

Syd([initial cost], [salvage], 
[lifespan], [period])

4,090.91 (yearly 
depreciation 
allowance for 
the first year)

Formatting
Applies bold, underline, or italic formatting to the input.

Function Type Description Example Formula Example 
Return

Bold Applies bold formatting to the 
input.

Bold(‘This is bold.’) This is bold.

Italic Applies italic formatting to the 
input.

Italic ('This is italic.’) This is italic.

Underline Applies underline formatting 
to the input.

Underline ('This is 
underlined.’)

This is 
underlined.

Logical
Logical functions can be used to handle conditional information.

Function Type Description Example Formula Example 
Return

And Returns TRUE if all arguments 
are true, or FALSE if any are 
false. Can take more than two 
arguments.

AND(2+2=4,2+3=6) FALSE

False Displays FALSE FALSE FALSE
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Function Type Description Example Formula Example 
Return

If If a condition is true, then the 
first input is returned. If it is 
false, then the second input is 
returned. 

if({OrderDetail.Price}= 
0,’FREE’,{OrderDetail.Price}) 

FREE if 
price is 0, or 
displays price

Not Reverses value of argument. 
Argument must be True/False. 

Not(FALSE) TRUE

Or If any argument is true, return 
TRUE. Can take more than 
two arguments.

OR(2+2=4,2+3=6) TRUE

Switch This function should be used 
instead of placing if() functions 
inside of if() functions. Takes 
any even number of inputs 
arguments. All arguments 
will be tested against the first 
argument in sequence until 
one is found to be true, then 
the next argument is returned. 
If no arguments are found to 
be true, second argument is 
returned. 

Switch({Categories. 
CategoryName}, ”NOT 
FOUND”, “Beverages”, 
“Drink up!”, “Condiments”, 
“Enhance”, “Confections”, 
“Sweet Tooth”)

If none are 
true, NOT 
FOUND. If 
Beverages 
category is 
true, Drink 
Up!

True Displays TRUE TRUE TRUE

Operators 
Symbols that denote operations.  

Function Type Description Example Formula Example 
Return

& And "These"&"go"&"together" These go 
together

+ Plus 10+5 15

- Minus 10-5 5

* Multiplied by 10*5 50

/ Divided By 10/5 2

Other
Miscellaneous functions that do not fit into other categories. 
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Function Type Description Example Formula Example 
Return

CellValue Returns the value of the 
current cell. This function 
is only used in conditional 
formatting.

CellValue()>150 TRUE (if price 
is grater than 
150)

ExcelFormula Passes an Excel formula to an 
Excel report.

ExcelFormula 
("SUM(A1:A100)")

Will pass 
SUM(A1:A100) 
to Excel

ExportType Returns the exported format 
type.

ExportType() PDF

FilterValue Returns the current value of 
a filter as a string for display 
purposes. First argument is 
filter value. Second argument 
is sub-index if there are 
multiple values. 

FilterValue(2,2) Second item 
in filtered list.

Hyperlink Creates a hyperlink to an 
external website. First 
argument is URL of website. 
Second argument is display 
text (optional).

Hyperlink(‘www.Euna Grants.
com’, ‘Euna Grants’)

Euna Grants

LoadImage Loads a server side image 
based on the input path into 
the cell.

LoadImage({Categories.
Picture})

PageNumber Returns the current page 
number for HTML, PDF, and 
RTF reports.

PageNumber() 1

StripHTMLTags Removes any HTML tags from 
the input string.

StripHtmlTags("<h1>This is 
heading 1</h1>")

This is 
heading 1

String
Commonly used for interpreting and manipulating text fields.

Function Type Description Example Formula Example 
Return

Concatenate Joins several text strings into 
one text string. Can also use & 
symbol.

Concatenate(“This “, “is “, 
“one string!” )

--OR--

"This"&"is"&"one string!"

This is one 
string!



REVISION: 2025-05-13

CUSTOM REPORTING

42

Powered by AmpliFund
Appendix  |  Formula Types

Function Type Description Example Formula Example 
Return

Left Returns the first character(s) 
of a text string. First argument 
is string. Second argument 
is number of characters to 
display.

Left(“example”, 2 ) ex

Len Converts all uppercase letters 
in a text string to lowercase.

Lower(“EXAMPLE” ) example

Mid Returns a specific number of 
characters from a text string 
starting where you specify. 
First argument is string. 
Second argument is starting 
character. Third argument 
is number of characters to 
display.

Mid(“example” , 2, 3) xam

NewLine Begins a new line of text. NewLine()

Replace Replaces part of a text string. 
First argument is string. 
Second argument is starting 
character. Third argument 
is number of characters to 
replace. Fourth argument is 
string to insert. 

Replace("example", 2, 3, "*") e*ple

Right Returns the last characters in 
a text string. First argument 
is string. Second argument 
is number of characters to 
display.

Right("example", 2) le

Trim Removes all spaces from 
text except for single spaces 
between words.

Trim("This     sentence     has   
weird    spacing.", 2)

This sentence 
has weird 
spacing.

Upper Converts text to uppercase. Upper("example") EXAMPLE

Value Converts a text string that 
represents a number to a 
number.

Value("$1,000") 1000
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